Welcome to ProSeries® tax software

For information about this topic... | Look here...
---|---
What’s new with ProSeries tax software for 2007 | Page 1
Computer system requirements | Page 3
Getting ready for the 2007 tax season | Page 4
Getting your computer system ready | Page 7
Installing ProSeries software for the 2007 tax year | Page 9
Setting up the ProSeries program | Page 13
Setting ProSeries options | Page 17
Transferring data from ProSeries 2006 client files | Page 21
Setting up the Access Rights feature | Page 22
Product licensing | Page 23
Keeping your ProSeries tax products up-to-date | Page 25
Preparing your clients’ federal and state returns | Page 27
Setting up other ProSeries features | Page 33
Getting information and help | Page 34
Using ProSeries.com and My ProSeries | Page 36
Filing returns electronically | Page 37
Overview of Bank Products | Page 47

For information about specific topics after you install the ProSeries program:

- See the ProSeries User’s Guide (as explained on page 36 of this guide).
- Enter keywords or a question in the Search Help field on the Help toolbar (located near the top-right corner of the ProSeries window), then click Search.
  
  Important: For information about a specific type of return, start or open a return of that type before you start the search.

What’s new with ProSeries tax software for 2007

The following table summarizes major enhancements to ProSeries tax software for the 2007 tax year. This is not an all-inclusive list of changes.

| Feature... | What’s new...
|---|---
| Client Checklist feature* | • Customized client checklists can help returning 1040 clients collect all the documents and information you’ll need before their appointment.
  • After you transfer data from 2006 ProSeries/1040 client files, use the Client Checklist command on the Tools menu to preview and edit client checklists. You can print client checklists singly and in batches. |
The Client Checklist, Client Presentation, and Client Advisor features are available if you’re using ProSeries/1040 on an Unlimited basis.

For information about some of the enhancements to specific ProSeries tax products:

- See the product Release Notes that accompanied the ProSeries CD, or
- Click the Help button on the ProSeries toolbar to open the Help Center, then:
  - Select ReadMe Information, then select the ProSeries tax product, or
  - Select What’s New This Year, or
- Open a return for that ProSeries tax product, go to the Search Help field (on the Help toolbar), type keywords in the Search Help field, then click the Search button. Review the list of search results in the Help Center. Click the blue, underlined title of a search result to see more information.
Computer system requirements for stand-alone computers

**Important:** If you purchased ProSeries/Network Version, see the ProSeries Network Installation Guide for information about the system requirements for network servers and user workstations in a networked environment.

Make sure that each computer on which you intend to use ProSeries software for the 2007 tax year meets or exceeds the minimum requirements for all relevant components. The minimum requirements and recommendations for ProSeries 2007 software differ from those for ProSeries 2006 software.

**Tip:** If you want to use a plug-in utility named Get System Info to get information about your system, go to http://web.intuit.com/support/sysinfo, then follow the instructions.

The minimum requirements shown below should provide adequate performance on most computer configurations. The software might not operate as designed on systems that don't meet the minimum requirements. For more information about how system requirements can affect ProSeries operation, go to http://www.proseries.com/sysreq.

<table>
<thead>
<tr>
<th>Component</th>
<th>Recommendation</th>
<th>Minimum Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>2.0 GHz or faster</td>
<td>800 MHz</td>
</tr>
<tr>
<td>Memory</td>
<td>1 GB RAM or more. More memory normally results in improved performance.</td>
<td>512 MB RAM. More memory may be required if you install many products and have a large number of clients.</td>
</tr>
<tr>
<td>Hard disk space</td>
<td>2 GB or more, depending on the number of products you install and the number of clients you have.</td>
<td>850 MB. More space may be required if you install many products and have a large number of clients.</td>
</tr>
<tr>
<td>Windows operating system</td>
<td>Windows XP - Home, Media, or Professional edition, (service pack 2 or later) Windows Vista - Home Basic, Home Premium, Business, or Ultimate edition</td>
<td>Windows 2000 (service pack 4 or later) <strong>Note:</strong> ProSeries software for the 2007 tax year shouldn’t be installed on a computer with a Windows NT, Windows 98, or Windows ME operating system.</td>
</tr>
<tr>
<td>Screen resolution</td>
<td>1024 x 768 or higher</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>Printer</td>
<td>Hewlett-Packard LaserJet with 2 MB of printer memory PCL compatible printer with 2 MB of printer memory  <strong>Note:</strong> Inkjet printers are not recommended.</td>
<td>Hewlett-Packard LaserJet or PCL compatible printer with 2 MB of printer memory <strong>Note:</strong> GDI printers are not supported.</td>
</tr>
<tr>
<td>CD drive</td>
<td>24X or faster</td>
<td>12X or faster</td>
</tr>
<tr>
<td>Internet Browser</td>
<td>Microsoft Internet Explorer 6.0 or later</td>
<td>Microsoft Internet Explorer 6.0 <strong>Note:</strong> Internet Explorer 6.0 is installed if Internet Explorer 6.0 or later isn’t already installed.</td>
</tr>
<tr>
<td>Internet connection</td>
<td>High-speed Internet connection, such as T-1, DSL, or cable modem</td>
<td>56.6 K modem</td>
</tr>
<tr>
<td>Internet Service Provider (ISP)</td>
<td>ProSeries software works with most ISPs. Contact your ISP if you have a specific question. <strong>Note:</strong> An ISP is required for features that use the Internet, such as electronic filing and the online delivery of products and product updates.</td>
<td></td>
</tr>
</tbody>
</table>
Getting ready for the 2007 tax season

Know your responsibilities. You and your clients are responsible for correctly reporting all information that is required by the Internal Revenue Service or applicable state taxing agency, and for the accuracy of each return that you file.

Be familiar with your computer system. If you’re unfamiliar with the basic operation of your computer, your Microsoft Windows operating system, or your computer network (if applicable), read the owner’s guide for your computer, Windows help, or the network documentation.

Understand the ProSeries License Agreement. The ProSeries License Agreement opens at the start of the installation procedure. After the software has been installed, you can review the ProSeries License Agreement in the Help Center or in the ProSeries User’s Guide. Please note the following conditions of the ProSeries License Agreement:

- You are licensing the software for use by a named entity and its employees at one identified location.
- You are representing to Intuit® that the firm name and address you provide is the primary firm name and location used in the normal course of business.
  - This is the name and address under which you market yourself and your professional services.
  - This firm name and address will appear in the “Paid Preparer” designation on tax returns.
- You may enter information about as many preparers as needed, provided that they all are employees of the firm listed at that particular address.
- Multiple preparers who operate as separate and distinct firms—even if they share office space—are considered to be unique. Each preparer must purchase a license for his or her own copy of the ProSeries software.

Preparing for electronic filing

To file returns (or extension request forms) electronically, you must be able to connect to the Internet from the computer on which you install the ProSeries program. In addition, you must have an IRS-issued Electronic Filing Identification Number (EFIN).

Tip: Your firm can have an EFIN, and preparers can have their own EFINS.

If you are new to electronic filing or no longer have a valid EFIN, you can apply for one using either of the following methods:

- Online. To use the IRS e-file application, go to http://www.irs.gov, select the e-file link, then click on the e-services link in the e-file for Tax Professionals section.
- Form 8633. Submit Form 8633, Application to Participate in the IRS e-file Program.

Important: Be sure to use the version of Form 8633 dated July 2003. If you submit an earlier version, the IRS will reject your application. The IRS recommends that you submit your application at least 45 days prior to the date that you intend to begin filing returns electronically. You can find Form 8633 and information about electronic filing at the IRS Web site, which is http://www.irs.gov/.

Tip: The IRS strongly recommends that you use the Online method to apply for an EFIN.

You can find information about electronic filing at http://www.proseries.com. Select Products, then Electronic Filing. If you have additional questions about electronic filing, call the IRS e-help desk at 1-866-255-0654.
State enrollment requirements
Some states require additional electronic filing enrollment paperwork. Verify the electronic filing enrollment requirements for each state where you plan to file returns electronically.

You can link to each state taxing agency's Web site from http://www.proseries.com. Select Resources, then Tax Links, then State Tax Departments, then the name of the state.

For more information about electronic filing, see “Filing returns electronically” on page 37.

Preparing to offer bank products
When you file your clients' individual returns electronically, they can receive loans based on their expected federal refunds in the form of:

- Refund Anticipation Loans (RALs)
- Refund Anticipation Loan Direct Deposits (RALDDs)
- Refund Transfers (RTs)
- Refund Transfer Direct Deposits (RTDDs)

**Tip:** Under certain circumstances this year, you can offer an individual return client an RT or RTDD based on the expected refund from a state return.

In addition, when a client receives proceeds based on a bank product, your fees are deducted from the client's refund and deposited into your bank account electronically.

Before you can offer bank products to your clients, you must first apply to Santa Barbara Bank & Trust or Republic Bank to participate in their banking products program.

To apply, go to http://www.proseries.com, select Products, then Bank Products, then select the Enroll Now link for the bank that you want.

**Tip:** The first time you start the ProSeries program, you see an Enroll with SBBT dialog box that includes a link to the applicable page at ProSeries.com. You also can link to that ProSeries.com page from the Bank Products section of the Options dialog box.

For more information about bank products, see “Overview of Bank Products” on page 47.

Preparing to accept major credit cards and eChecks
You can use the ProSeries/Merchant Account Service to allow clients to pay for your services using major credit cards and e-Checks.

If you aren't already a ProSeries/Merchant Account Service customer, you must apply for the ProSeries/Merchant Account Service program.

To apply for this program, go to http://www.proseries.com, select Products, then Merchant Account Services, then Apply Now.

**Tip:** To apply for the ProSeries/Merchant Account Service program after you install the ProSeries program, go to the Tools menu, select Accept Credit Cards/eChecks, then select Sign Up.

Ordering presentation folders and envelopes
Preparing for ProSeries setup

You can use each ProSeries tax product and electronic filing product on an unlimited basis or a pay-per-return basis.

- **When you use a ProSeries tax product on an unlimited basis**, you pay a fixed fee to purchase that product, but you don’t pay a fee to print or convert returns for electronic filing.

- **When you use a ProSeries electronic filing product on an unlimited basis**, you pay a fixed fee to purchase that product, but you don’t pay a fee to transmit returns electronically.

- **When you use a ProSeries tax product on a pay-per-return basis**, you don’t pay a fee to purchase that product (unless you don’t purchase any ProSeries tax products on an unlimited basis), but you must authorize payment for each return before you can print it or convert it for electronic filing.

- **When you use a ProSeries electronic filing product on a pay-per-return basis**, you don’t pay a fee to purchase that product, but you must authorize payment for each return before you can transmit it electronically.

When you install ProSeries software, you select the tax products that you want to install. If you haven’t already purchased the unlimited version of a tax product or corresponding electronic filing product, the pay-per-return version of that product will be installed.

**Important:** If you want to use a ProSeries product on an unlimited basis, call ProSeries Sales at 1-800-934-1040 or order online at http://www.proseries.com. The product information in your customer record will be updated. Product licensing can be done automatically if your computer is connected to the Internet (which is the recommended method), or you can use the manual method for product licensing (by selecting License Products from the ProSeries Tools menu).

**Tip:** To learn more about pay-per-return products before you install ProSeries software, go to http://www.proseries.com, select Resources, then ProSeries User Guides, then ProSeries User Guide for Tax Year 2007, then chapter 8, “Using Pay-Per-Return Products.”

You might be prompted for information about the following topics during ProSeries setup. (You can enter this information as you use ProSeries later, if you prefer.)

<table>
<thead>
<tr>
<th>For this topic...</th>
<th>You should know this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Licensing</td>
<td>The Customer Number and ZIP code that are printed in the Sold To: area of the packing slip (which accompanied the ProSeries CD)</td>
</tr>
<tr>
<td>Firm and Preparers</td>
<td>Basic information about your firm and the preparers who will be using the ProSeries software</td>
</tr>
<tr>
<td>Electronic Filing</td>
<td>If you’re going to offer electronic filing to your clients, information about the person(s) who will be the electronic filing contact(s) for your firm</td>
</tr>
<tr>
<td>Bank Products</td>
<td>If you’re going to offer bank products to your clients through Santa Barbara Bank &amp; Trust, your bank products registration information, including information about the bank account where your fees will be deposited by Santa Barbara Bank &amp; Trust</td>
</tr>
<tr>
<td>Billing</td>
<td>If you’re going to use ProSeries billing features, how you want to set up billing options such as standard fees, hourly charges, and per-form charges</td>
</tr>
<tr>
<td>Access Rights feature</td>
<td>Whether you want to use the Access Rights feature to control access to the program and to specific features, and what the appropriate User Role (e.g., Administrator, Power User, Tax Preparation, Data Entry) is for each employee</td>
</tr>
</tbody>
</table>
Getting your computer system ready

You can install ProSeries software for stand-alone use or for network use. First, decide how you will install and use ProSeries software, then get your computer(s) ready.

**Important:** Before you install ProSeries software for network use, we strongly recommend that you purchase the ProSeries/Network Version product.

Decide how you are going to use ProSeries software

How you install and use ProSeries software depends on several factors, including the number of computers on which you want to use ProSeries.

**One computer.** If you’re going to use ProSeries software on one computer, install the program for stand-alone use on that computer’s hard drive.


**Multiple computers.** If you’re going to use ProSeries software on more than one computer, you can install the program for stand-alone or network use.

- **Stand-alone use.** If each preparer maintains an independent set of clients, install the ProSeries program for stand-alone use on the hard drive of each computer.
  
  See “Installing ProSeries software for the 2007 tax year” on page 9 for instructions.

  **Important:** If your firm will be filing returns electronically from more than one computer using the same EFIN on each one (and the program is installed for stand-alone use on each computer), be sure to see “If more than one computer will be using the same EFIN” on page 38.

- **Network use.** If preparers regularly share tasks and review returns for other preparers, install the ProSeries program for network use.

  **1. ProSeries Admin workstation.** Install the ProSeries shared network components to a shared drive from the computer you choose to be the ProSeries Admin workstation. You’ll also install and set up the ProSeries program on the ProSeries Admin workstation at that time.

  Any computer (including the network administrator’s workstation) can be the ProSeries Admin workstation. However, we strongly recommend that the ProSeries Admin workstation have an Internet connection to help ensure that you always have the latest versions of ProSeries tax products.

  **2. ProSeries User workstations.** Install and set up the ProSeries program on each additional computer that will run the ProSeries program (and that will access ProSeries shared network components and client files from the shared drive where ProSeries is installed).

  If you purchased ProSeries/Network Version, see the ProSeries Network Installation Guide that you received for instructions.

  **Important:** If a preparer is going to prepare returns on a laptop or notebook computer that will be mobile (in a manner permitted by the ProSeries Software License Agreement), install ProSeries software for stand-alone use on that computer’s hard drive.

  **Important:** If you install ProSeries software for stand-alone use on a laptop or notebook computer, be sure to use the Copy/Backup and Restore commands on the Client File Maintenance menu (accessed from the File menu) when moving client files from the network to the laptop or notebook, or from the laptop or notebook to the network.

**Tip:** You can use the Access Rights feature on stand-alone and network systems.
**Prepare your computer system**

We suggest you review the following before installing ProSeries software.

**Internet connectivity**

Having an Internet connection allows you to take advantage of ProSeries features such as online delivery of tax products and tax product updates, product licensing, electronic filing, bank products, and the ProSeries.com Web site.

We recommend that the following computers have a valid Internet connection before you install ProSeries software:

- **If stand-alone installation.** Each computer that will run ProSeries software
- **If network installation.** The ProSeries Admin workstation because all product downloads and product updates must be done at the ProSeries Admin workstation

**Computer performance**

We strongly recommend that you do the following for each computer that will run ProSeries software:

- Install the latest updates for your operating system from http://www.microsoft.com.
- Use virus-protection software to check for viruses on the hard drive. Make sure the latest software updates are installed.
- Use anti-spyware software to check for spyware and adware on the hard drive. Make sure the latest software updates are installed.
- Install a firewall (software or hardware) to prevent unauthorized access to your computer system from the Internet.
- Run the Scan Disk and Disk Defragmenter Windows system tools to correct any errors on the hard drive and speed up access to the contents of the hard drive.

**Know the location of your ProSeries 2006 client files**

ProSeries software for the 2007 tax year can transfer data from ProSeries 2006 client files, ProSeries Express Edition 2006 client files, and ProSeries Basic Edition 2006 client files into new ProSeries 2007 client files. If you used ProSeries software for the 2006 tax year, make sure you know the location of last year’s ProSeries client files—especially if your ProSeries 2006 client files are stored on 3.5-inch disks or other external storage media.

**Tip:** The default installation location for the ProSeries 2006 client file directory for stand-alone installations was C:\ProWin06\06Data. For network installations, it was x:\ProSeries\ProNet06\06Data, where x represents the letter of the drive where ProSeries network components were installed, but not necessarily Drive X.

**Know the location of the other important data files**

If you use QuickBooks® software, Quicken® software, Intuit EasyACCT® software, ProSeries/Fixed Asset Manager software, a trial balance program, or any other software from which you expect to import client data, make sure you know where the relevant data files are located.

**Know user-related information for the Access Rights feature**

If you’re going to use the Access Rights feature that’s discussed in “Setting up the Access Rights feature” on page 22, be prepared to assign a User Name, a Password, and a User Role to each person who will be authorized to use the software. If you used the Access Rights feature last year, make sure you recall an Administrator User Name and Password.
Installing ProSeries software for the 2007 tax year

This section explains how to install ProSeries software on each computer that will use ProSeries independently.

You install ProSeries software from the first ProSeries CD that you receive (or via the Internet from ProSeries.com). Each ProSeries CD contains the latest version of every ProSeries tax product that’s currently available. (For details about each ProSeries CD, see “Software service and ProSeries CD delivery information” on page 26.)

When you run the ProSeries installation program, select each ProSeries tax product that you expect to use for the 2007 tax year—even if you’re only installing Client Organizer and the draft version of ProSeries/1040 from the ProSeries Head Start CD. The installation program installs each tax product that you select, provided the tax product is on the ProSeries CD. The ProSeries User’s Guide is also installed.

Important: We strongly recommend that you install ProSeries/1040 and/or Client Organizer from the ProSeries Head Start CD so you can receive other products via the Internet as soon as possible. For more information, see “Keeping your ProSeries tax products up-to-date” on page 25.

Before you install ProSeries software for the 2007 tax year, note the following important information:

- **Release Notes.** Read the printed Release Notes and any other material that accompanied the ProSeries CD.
  
  THE RELEASE NOTES MAY CONTAIN, AMONG OTHER THINGS, ADDITIONAL LICENSING TERMS THAT GOVERN THE USE OF THE PROSERIES SOFTWARE AND RELATED SERVICES.

- **Packing slip.** The packing slip that accompanied the ProSeries CD contains your Customer Number and (Sold To:) ZIP code, which is information you will need during the initial installation and setup of the software.

Tip: Your Customer Number and ZIP code are the only information on the packing slip that you'll need to provide for product licensing purposes.

Installing ProSeries software for stand-alone use

Important: If you’re installing ProSeries software for network use, refer to the installation instructions in the ProSeries Network Installation Guide.

To install ProSeries software on a computer for stand-alone use:

1. Close all open applications and turn off any virus-protection utilities on the computer.

2. If you’re installing from a ProSeries CD, insert the ProSeries CD into the appropriate drive. Don’t remove the CD from the drive until the installation process is complete.

   If you’re installing from an .EXE file that you downloaded from ProSeries.com, start Windows Explorer, go to C:\Temp, then double-click the .EXE file.

3. In the ProSeries Installation dialog box, select Install ProSeries Software.

   If you’re installing from a ProSeries CD and the ProSeries Installation dialog box doesn’t appear automatically:

   a. Go to the Windows taskbar, select Start, then select Run.

   b. In the Run dialog box, type x:\CDSETUP (where x represents the letter of the drive containing the ProSeries CD), then select OK.
c. In the ProSeries Installation dialog box, select Install ProSeries Software, then continue to Step 4.

4 In the Welcome dialog box, select Next when you’re ready to continue.

5 A System Warning dialog box opens if your computer doesn’t meet the minimum system requirements for the ProSeries 2007 software. (For more information, see “Computer system requirements for stand-alone computers” on page 3.) If the System Warning dialog box opens, read the information, then do one of the following:
   • Select Cancel to exit the installation program, then correct the situation(s) identified in the System Warning dialog box. After your computer meets the minimum system requirements, go back to page 9 and start the installation procedure again.
   • Check the box indicating that you understand you may not receive technical support for issues that you may encounter while using the ProSeries program, then select Next to continue to Step 6.

   **Important:** We strongly recommend that you select Cancel and correct the situation(s) identified in the System Warning dialog box. For information about how system requirements can affect ProSeries operation, go to http://www.proseries.com.

6 In the Software License Agreement dialog box, read the ProSeries License Agreement to understand the scope of your rights to use ProSeries software.
   • Select I accept the terms of the license agreement if you agree to accept all the terms of the ProSeries License Agreement, then select Next and continue to Step 7.
   • Select I do not accept the terms of the license agreement if you don’t agree to accept all the terms of the ProSeries License Agreement, then select Cancel and exit the installation program.

   **Important:** If for any reason you find the ProSeries License Agreement unacceptable, do not install the software. Contact ProSeries Customer Service for a refund instead.

7 In the Select an Installation Type dialog box, select Stand Alone, then select Next.

   **Important:** If you select Network, go to the Network Installation Guide and follow the instructions for installing the Network Version of ProSeries.

8 In the Select Destination Directory dialog box, do one of the following:
   • Select Next if you want to install ProSeries software in a \PROWIN07 directory on the drive that’s shown in the dialog box. (That drive will be C: or the drive on which last year’s ProSeries was installed.) Skip to Step 10.
   • Select Browse if you want to install ProSeries software to a different drive or directory. Continue with Step 9.
9 In the Select Folder dialog box, take the following steps:

a. Select the drive where you want to install ProSeries software.

b. After selecting the drive, type the folder name \ProWin07 in the Folder name field so it appears after the drive you selected, then select OK.

PROWIN07 directory. For best results, use PROWIN07 as the name of your 2007 ProSeries directory. Don’t install ProSeries software to the root of a drive. Be sure you install ProSeries software to a directory.

c. When prompted to create the PROWIN07 directory in the location that you’ve specified, select Yes.

d. When you return to the Select Destination Directory dialog box, select Next. Continue with Step 10.

10 In the Tax Year 2007 Product Selections dialog box, select the products that you expect to use for the 2007 tax year, then select Next.

Tip: If you used ProSeries software for the 2006 tax year, the products that were installed last year may already be selected.

Every ProSeries tax product for 2007 is shown in this dialog box, including products that may not be available yet. Select all ProSeries tax products that you intend to use this tax season. You can install additional products later, as described in “Keeping your ProSeries tax products up-to-date” on page 25. Products you select here that you haven’t purchased as unlimited will be installed for pay-per-return use.
If any of the products you selected aren’t on the CD, you’ll see the Installation Note
dialog box. Review the list of products that will be installed later (when they become
available), then select OK. (For more information, see “Keeping your ProSeries tax
products up-to-date” on page 25.)

In the Installation Details dialog box, review all the information, including the
Required Space and Available Space information, then select Next.
The installation program installs all available ProSeries tax products that you
selected, then verifies that all applicable files were installed correctly. Continue with
Step 13.

Installation Failed dialog box. If you see this dialog box, a product was not installed
properly. Select Help to find a possible solution, then select Exit to exit the
installation program.

Additional components. Wait while additional components, such as any necessary
fonts, Internet Client software, the ProSeries User’s Guide, a search engine, a PDF
print driver, and ProSeries Product Licensing components are installed. Dialog boxes
and progress bars keep you informed.

Internet Explorer. If Microsoft Internet Explorer 5.5, service pack 2 or later isn’t
installed on your computer, the installation program installs Internet Explorer 6.0
before continuing. ProSeries software requires portions of Internet Explorer 5.5,
service pack 2 or later to run properly.

Important: If ProSeries installs Microsoft Internet Explorer, you are prompted to
restart your computer. After the computer restarts, the installation program will
finish the ProSeries installation procedure.

Restart Windows message. Restart your computer if you are prompted to do so.

If the installation program doesn’t resume after you restart the computer,
start the ProSeries program by double-clicking the ProSeries 2007 shortcut
icon on your Windows desktop. The Connected Customer Wizard will
begin. Go to “Setting up the ProSeries program” on page 13 now.

Setup Complete. In the Setup Complete
dialog box, select Finish, then continue
with Step 17.

We recommend that you leave the check
mark for the Launch ProSeries option.

If the Launch ProSeries option was
selected: The Connected Customer
Wizard begins automatically. Proceed to
“Setting up the ProSeries program” on
page 13.

If the Launch ProSeries option wasn’t
selected: You return to the ProSeries
Installation dialog box. Select Exit to
return to the Windows desktop. Continue with Step 18.

After you return to the Windows desktop, start the ProSeries program by
double-clicking the ProSeries 2007 shortcut icon. The Connected
Customer Wizard will begin automatically.

Continue with “Setting up the ProSeries program” below.
**Troubleshooting suggestions**

If you have difficulty installing or starting the ProSeries program, see the troubleshooting suggestions in the following table.

<table>
<thead>
<tr>
<th>If this occurs...</th>
<th>Do this...</th>
</tr>
</thead>
</table>
| A dialog box informs you that your computer doesn’t have enough disk space | 1. Go to the **Start** menu, point to **Programs**, then **Accessories**, then **System Tools**, and then select **Disk Cleanup**.  
2. Try to install the ProSeries software again.  
3. If there still isn’t enough disk space, remove unused programs or data from the hard drive. |
| A dialog box informs you there was an error | 1. Write down the error message, then restart the computer.  
2. Go to the **Start** menu, point to **Programs**, then **Accessories**, then **System Tools**, and then select **ScanDisk**.  
3. After ScanDisk is complete, go to the **Start** menu, point to **Programs**, then **Accessories**, then **System Tools**, and then select **Disk Defragmenter**.  
4. After Disk Defragmenter is finished, run your virus-protection software.  
5. Clean the ProSeries CD with a soft cloth, then try to install the ProSeries software again. |
| The ProSeries program doesn’t start when it should | 1. Restart the computer.  
2. Make sure no other applications are running.  
3. Double-click the **ProSeries 2007** icon on the desktop. |
| You still are unable to install or start the ProSeries program | Start your Internet browser, then go to http://www.proseries.com to see additional troubleshooting solutions. |
| You are unable to resolve the problem | Contact ProSeries Technical Support by phone, e-mail, or chat. Refer to http://www.proseries.com/support for contact information and hours of operation. To save time, gather as much information as possible, including any error messages. If your computer is networked, have your network administrator available. |

**Setting up the ProSeries program**

The first time you start the ProSeries program, the Connected Customer Wizard helps you set up the program if there’s a valid Internet connection.

**Network.** Start the ProSeries program from the ProSeries Admin workstation the first time, then set up ProSeries from the ProSeries Admin workstation before anyone sets up other workstations to run the program.

**If the computer has a valid Internet connection**

If the computer has a valid Internet connection, the Connected Customer Wizard performs the following important tasks to save you time:

- **Internet Connection.** Connects via the Internet to an Intuit ProSeries server that contains customer information.
- **Firm information.** Retrieves the name and address of your firm from the Intuit ProSeries server.
• **Product licensing.** Licenses your ProSeries tax software to your firm, based on your Customer Number, ZIP code, and information in the customer database on the Intuit ProSeries server.
  - **Unlimited.** Products you've purchased as unlimited are licensed as unlimited.
  - **Pay-Per-Return.** All other products are licensed as pay-per-return.
  - **Network version.** If you've purchased ProSeries/Network Version, the program is licensed for network use. For more information, see the ProSeries Network Installation Guide.

**Important:** Product licensing information is **not** printed on the packing slip. For more information, see “Product licensing” on page 23.

• **Product updates.** Checks for updates to the products that were installed from the ProSeries CD, then downloads and applies the relevant updates, if any.

• **New products.** Checks for products that you selected for installation that weren't installed from the ProSeries CD, then downloads and installs those products, if any.

**Tip:** If you need to edit information that the Connected Customer Wizard retrieves from the Intuit ProSeries server, you can do that in the ProSeries program later.

Proceed to “Using the Connected Customer Wizard” below.

### If the computer doesn’t have a valid Internet connection

If the computer doesn’t have a valid Internet connection, you see a dialog box that explains the benefits of being connected and asks whether you want to start the Internet Connection Setup Wizard. If you don’t establish a valid Internet connection, the Options Setup Wizard begins. Proceed to “Setting ProSeries options” on page 17. You’ll have an opportunity to license your products and to enter your firm’s name and address later.

### Using the Connected Customer Wizard

When the Connected Customer Wizard starts, go to:

- Step 1 if the computer doesn't have a valid Internet connection
- Step 2 if the computer has a dial-up Internet connection
- Step 3 if the computer has a valid, non-dial-up Internet connection

1. **If the computer doesn’t have a valid Internet connection**, a dialog box explains the benefits of being connected.
   - If you think you might be able to establish a valid Internet connection, select **Yes** to run the Internet Connection Setup Wizard.
     After you establish a valid Internet connection and return to the Connected Customer Wizard, continue with Step 2.
   - If you know you won’t be able to establish a valid Internet connection now, select **No** to exit the Connected Customer Wizard.

     The ProSeries program will start automatically. Proceed to “Setting ProSeries options” on page 17.

     **Tip:** To establish a valid Internet connection at a later time, go to the ProSeries Help menu and select **Internet Connection Setup**.

2. **If the computer has a dial-up Internet connection**, you are prompted to connect to the Internet if the computer isn’t currently connected. After you connect to the Internet, continue with Step 3.

3. In the **Connected Customer** dialog box, select **Choose Products to Install** if you want to view the products that you selected to install, or if you want to select additional
Install and Setup

15

products for installation. Select **Next** in the **Connected Customer** dialog box when you're ready to continue to Step 4.

---

**4** The **Customer Information** dialog box opens so you can enter or verify your Customer Number and the ZIP code that's shown in the **Sold To:** area on the ProSeries packing slip.

---

**5** Select **Next** after you enter your Customer Number and ZIP code.

The **Progress** dialog box keeps you informed about what the Connected Customer Wizard is doing.

- The Connected Customer Wizard adds a check mark when it successfully completes a task.
- If the Connected Customer Wizard is unable to complete a task, you'll see an “X” instead.

**6** Select **Next** after the Connected Customer Wizard finishes the setup tasks.

**7** In the **Verify Firm Information** dialog box, review the information that appears. This is the information that we have on file for your firm (based on the Customer Number and ZIP code that you entered).

**Important:** Review this information carefully. The ProSeries program prints this information on all returns prepared by your firm.
8 Select Next.
   • If you selected Yes, skip to Step 12.
   • If you selected No, you see the Enter Firm Information dialog box. Continue with Step 9.

9 Enter or edit your firm's name and address, then select Next.

10 If you make minor changes to your firm's name or address, the program saves that information.
   If you make significant changes to your firm's name or address:
   • The Connected Customer Wizard connects to an Intuit server via the Internet, then transmits the updated information about your firm, or
   • You see a dialog box that instructs you to call Customer Service at 1-800-374-7317 to update the information about your firm in our records.

Follow the on-screen instructions to continue setting up the ProSeries software.

11 Review the firm and product information in the Product Licenses dialog box.

12 If there are products or product updates to download, wait while the ProSeries Update program downloads and installs those products and product updates. When the results of that process appear in the ProSeries Update dialog box, review the status of each product that you selected for installation.
   • Select Details to see more information.
• Select Print to print the information.
When you’re ready to continue, select Close.

13 After you close the ProSeries Update dialog box, you’ll see dialog boxes that help you set up various ProSeries options. Continue with “Setting ProSeries options” next.

Setting ProSeries options

The first time this year's ProSeries program starts, it transfers preferences and settings that you used with last year's ProSeries program if it locates that information on your system.

Important: If you installed ProSeries for network use, the program transfers last year's preferences and settings only if it starts from the ProSeries Admin workstation the first time.

● Not Transferred. If the program wasn’t able to transfer last year’s ProSeries preferences and settings, a dialog box asks “Do you plan to offer Electronic Filing of returns/extensions as part of your tax preparation practice for Tax Year 2007?”
  • If you answer Yes, the Options Setup Wizard starts. Continue with the next section, “Using the Options Setup Wizard.”
  • If you answer No, the Options Setup Wizard doesn’t start. Go to “Transferring data from ProSeries 2006 client files” on page 21.

● Transferred. If the program transferred last year's ProSeries preferences and settings:
  • The ProSeries Login dialog box opens if (and only if):
    - You used the Access Rights feature in last year's ProSeries program, and
    - Access Rights information was transferred from last year's ProSeries software.
    Enter a valid User Name and Password, then click OK to proceed.
  • The Prior Year Settings Transferred dialog box opens. When you see the Prior Year Settings Transferred dialog box, review the information, then select OK.

If electronic filing information was transferred, the Options Setup Wizard starts. Continue with the next section, “Using the Options Setup Wizard.”

If electronic filing information wasn’t transferred, a dialog box asks “Do you plan to offer Electronic Filing of returns/extensions as part of your tax preparation practice for Tax Year 2007?”
  • If you answer Yes, the Options Setup Wizard starts. Continue with the next section, “Using the Options Setup Wizard.”
  • If you answer No, the Options Setup Wizard doesn’t start. Go to “Transferring data from ProSeries 2006 client files” on page 21.

Using the Options Setup Wizard

The Options Setup Wizard helps you review and edit preferences and settings. The wizard starts automatically if you indicate that you’re going to offer electronic filing, or if you select OK in the Prior Year Settings Transferred dialog box.

To set ProSeries options:

1 When the Options Setup Wizard starts, the first dialog box you see welcomes you to the Options Setup Wizard. Select Next to see the Options Setup Wizard dialog box that’s shown next.
2 Select **Express Setup** or **Custom Setup**.

- If you select **Express Setup**, you see the Options Setup Wizard dialog boxes for the ProSeries options that you need to set before you complete returns.

- If you select **Custom Setup**, you first select the areas of the program that you want to set up. The choices are Basic Options, Transfer Options, Printing Options, and Electronic Filing Options. Next, you see the Options Setup Wizard dialog boxes for the areas of the program that you chose.

3 Select **Next**.

Most Options Setup Wizard dialog boxes are self-explanatory. However, the next sections discuss the following three topics in some detail.

- “Entering firm and preparer information” (see below)
- “Entering global billing information” (see page 20)
- “Enabling and scheduling Task Scheduler tasks” (see page 20)

4 Continue setting ProSeries options in the Options Setup Wizard dialog boxes.

5 When the **Congratulations** dialog box indicates that you completed the Options Setup Wizard, select **Finish** to save the options that you selected.


**Entering firm and preparer information**

You enter information about your firm in the Firm/Preparer Information dialog box. If you completed the Connected Customer Wizard described on page 14, you’ll see your firm’s name and address in the gray area of the Firm Information section.

**Tip:** If you don’t see your firm’s name and address, you’ll retrieve that information from an Intuit Internet server later, as explained in “Product licensing” on page 23.

Enter other information about your firm in the fields below the gray area. If the firm will be filing returns electronically, enter the firm’s Electronic Filing Identification Number (EFIN) and the name of the person that ProSeries Technical Support can contact if necessary.
Enter information about each of the firm’s preparers in the next section of the dialog box. If preparers will be filing returns electronically, also enter ERO Practitioner PIN, ERO Contact Name, and Electronic Filing Identification Number (EFIN) information in this section as applicable. If the ProSeries program transferred preparer information from last year’s program, just edit the information as necessary.

**Tip:** For information about any field in the Firm/Preparer Information dialog box, right mouse click the field, then select About <Field> on the pop-up menu.

This table explains some of the fields in the Firm/Preparer Information dialog box:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firm Name and Address</td>
<td>This must be the primary firm name and location used by you in the normal course of business (in other words, the firm name and address under which you market yourself and your professional services). This information prints in the Paid Preparer area on each tax return for which you are the paid preparer. If you prepare a return for which you are not the paid preparer, and you want to substitute an alternative “self-prepared return” or “non-paid preparer” designation in the paid preparer section of applicable forms instead of your company’s firm name and address, right mouse click on the Preparer Code field, then select About Preparer code on the pop-up menu to see specific directions on what to do in those situations. You can’t enter or edit your firm’s name or address in the Options Setup Wizard. To edit information in the shaded area after you finish the Options Setup Wizard, go to the Tools menu, select Options, select Firm/Preparer Info, select the Edit button, then follow the instructions. To enter your firm’s name and address after you finish the Options Setup Wizard, go to the Tools menu, select License Products, select Online or Manual, then follow the instructions.</td>
</tr>
<tr>
<td>Electronic Filing Identification Numbers and Efile Contact Names</td>
<td>If your firm has an Electronic Filing Identification Number (EFIN), enter the firm’s EFIN and an Efile Contact Name in the Firm Information section. If a preparer has an Electronic Filing Identification Number (EFIN), enter the preparer’s EFIN and an Efile Contact Name for that preparer in the Preparer/Electronic Return Originator (ERO) Information section.</td>
</tr>
<tr>
<td>Preparer Code</td>
<td>Enter up to three characters to identify the preparer. For example, enter the preparer’s initials or a numeric code. Each Preparer Code must be unique. As you prepare returns, enter this same code on the client’s Federal Information Worksheet (if an individual return) or in the preparer’s block on the signature form (if a business return) to associate that return with a particular preparer.</td>
</tr>
<tr>
<td>Print name in signature area?</td>
<td>Check this box to print the preparer’s name on the Preparer’s Signature line of the tax return. The preparer can then write his or her signature on top of or next to his or her printed name.</td>
</tr>
</tbody>
</table>
Entering global billing information

Use the Global Billing Options dialog box to set the billing options that you want to use for all clients. If the ProSeries program transferred global billing information from last year’s program, just edit the information as necessary.

Tip: If Client Organizer is the only installed product, you don’t see this dialog box.

Enabling and scheduling Task Scheduler tasks

ProSeries Task Scheduler automates two important tasks for you. Typically, you set up Task Scheduler to perform tasks late at night, when your system isn’t in use. We recommend that you enable the Download New/Update Existing Products task to help keep your ProSeries tax products current. If your firm will be filing returns electronically, we recommend you enable the Receive E-file related Acknowledgments task.

Tip: If Client Organizer is the only installed product, the Receive E-file related Acknowledgments task isn’t available.

When you enable at least one task, this dialog box indicates the days and time that Task Scheduler is scheduled to perform the enabled tasks. If you want to change the scheduled days or time, click the Modify Schedule button to open the Modify Schedule dialog box.

Important: If you schedule tasks to run during the night, the computer must be running and Task Scheduler must be able to connect to the Internet “unattended.” If your Internet connection requires a password, that password must be stored and available.

Tip: To run the Options Setup Wizard whenever you want from within ProSeries, go to the Help menu and select Options Setup Wizard. For more information, use Search.
Transferring data from ProSeries 2006 client files

The first time you start the ProSeries program, you are asked if you want to transfer last year’s client files. The transfer procedure is a simple way to start your clients’ ProSeries 2007 client files using the relevant data in their ProSeries 2006 client files.

**Tip:** You can transfer data from 2006 ProSeries/1040 client files to 2007 Client Organizer files or to 2007 ProSeries/1040 client files. If you transfer data from 2006 ProSeries/1040 client files to 2007 Client Organizer files, you can transfer data from those 2007 Client Organizer files to 2007 ProSeries/1040 client files later.

If you used ProSeries software last year, select Yes to go to the Transfer window, then do the five steps listed on the left side of the Transfer window.

1. Select the type of transfer you want to perform from the list of alternatives.
2. Select the location of your existing client files.
3. Select a location for the new client files.
4. Select the client files that you want to transfer data from, or click the Select All button.
5. After you’ve selected one or more clients, click Transfer.

**Important:** When transferring client data on a network, the location in the Transfer data files to... field (step 3) must be the directory where your ProSeries 2007 client files are being saved. This directory is set from the ProSeries Admin workstation during the Options Setup Wizard (or in the Directories section of the Options dialog box).

When you select Transfer, the program creates a new 2007 ProSeries client file for each selected client, then transfers the applicable data into the new ProSeries 2007 client file.

The Batch Transfer Status dialog box keeps you informed during the Transfer process, and the Transfer Log dialog box opens when the ProSeries program finishes transferring client data. Review the information, then select Close to go to HomeBase. HomeBase is discussed in “Preparing your clients’ federal and state returns” on page 27.

**Electronic filing.** If a client’s 2006 return was marked for electronic filing, that selection is transferred to the 2007 return. If your firm will be filing returns electronically, be sure to read “Filing returns electronically” on page 37.

**Important:** If your firm will be filing returns electronically from more than one stand-alone computer, and each computer is using the same EFIN, change the starting number in the DCN counter in the ProSeries program on all but one computer before opening any returns. For more information, see “If more than one computer will be using the same EFIN” on page 38.

**Tip:** For on-screen instructions, go to the Help menu, select Help Center, select Tutorial Videos, select Program Setup and Maintenance, then select Transferring Prior Year Data.
For more information about transferring data from ProSeries 2006 client files, use the Search Help feature on the Help toolbar or in the Help Center.

**Tip:** After you transfer data from your ProSeries/1040 2006 client files, you can use the Client Checklist command on the Tools menu to create Client Checklists for those clients. Each Client Checklist informs a returning Form 1040 client of the specific documents and information that you’ll need. You can print and email Client Checklists.

---

**Setting up the Access Rights feature**

The Access Rights feature can help control access to the ProSeries program and specific program features. If your firm enables the Access Rights feature, each user must enter a valid User Name and Password in a ProSeries Login dialog box every time he or she starts the ProSeries program. The User Role assigned to a User Name determines which program features a user can access.

**Important:** We recommend that the owner and/or the manager of the firm enable and set up the Access Rights feature.

**To enable and set up the Access Rights feature**

1. Go to the Tools menu, select Access Rights, then select Enable/Disable Access Rights feature.
2. In the first Access Rights Wizard dialog box, select Yes, I want to enable and setup the Access Rights feature, then click Next.

**Tip:** If you select No, I do not want to enable the Access Rights feature in the first Access Rights Wizard dialog box, then select Yes (recommended) in the next dialog box, you can protect the Access Rights feature with a User Name and Password so no one can enable the feature in the future without providing that User Name and Password.

3. Enter a User Name and Password for yourself in the next Access Rights Wizard dialog box, then click Next. The program assigns the Administrator User Role to that User Name, then asks whether you want to add additional user names. If you select “Yes,” the program opens the Manage Users dialog box shown here.

4. Select the Add New User button, then enter a User Name and a Temporary Password for a person who is authorized to use the ProSeries program.

**Important:** Be sure to note all User Names and Temporary Passwords.

5. Click the User Role field, then select a User Role in the User Role list. The choices are Administrator, Power User, Tax Preparer, Data Entry, and Add New Role.

6. Click OK to save the information and return to the Manage Users dialog box.

7. Repeat steps 2, 3 and 4 for each Access Rights User Name that you want to set up.

8. Provide each person with a User Name and Temporary Password as appropriate.

**Tip:** To see the Access Rights menu, go to the Tools menu and select Access Rights.
Product licensing

Product licensing is a system that licenses your ProSeries tax software to your firm. Product licensing is required before you can print returns, file returns electronically, or create PDF files that contain returns. Products that aren’t licensed for unlimited use can be used on a pay-per-return basis.

Product licensing uses your Customer Number and ZIP code with information in Intuit’s records to deliver the following to your ProSeries tax software:

- An unlimited-use license for each ProSeries tax product and ProSeries electronic filing product that you’ve purchased for unlimited use—even if those products haven’t been installed yet
- Your firm’s name and address
- A network license (if you purchased ProSeries/Network Version)

Tip: You can make minor changes to your firm’s name and address (such as changing “Dr.” to “Drive”) after ProSeries product licensing has occurred.

ProSeries product licensing can be performed using the Online method or the Manual method. For most ProSeries users, product licensing occurs online automatically.

Automatic, Online product licensing

The Connected Customer Wizard performs product licensing automatically when:

- You install ProSeries tax software for stand-alone use on a computer that has an Internet connection
- You install ProSeries tax software for network use from a computer (referred to as the ProSeries Admin workstation) that has an Internet connection

Important: When ProSeries is installed for network use, product licensing must be initiated from the ProSeries Admin workstation. Product licensing information is shared by all computers that have been set up as ProSeries workstations. See the ProSeries Network Installation Guide for more information.

Be sure to read “Updating your firm’s product licensing information” on page 24 of this guide.

Product licensing using the Manual method

If automatic, Online product licensing hasn’t been performed (as explained above), you’ll see the message “Product Licensing Required” in the HomeBase Message Center. When you click that message, you see a License Products dialog box that includes two options: Online (Recommended) and Manual. Select Manual, then select OK. You’ll see the License Products dialog box shown on the next page.

Tip: Ways that you can contact Intuit for manual product licensing include:

- Automated Touch Tone phone service (call 1-800-723-0692)
- Online service (go to http://www.proseries.com, then select Product Licensing)
1 Verify your Customer Number and ZIP code.

2 Enter your firm’s name and address. (This information must match the information contained in Intuit’s records.)

3 Contact Intuit using one of three methods. You will receive a unique Activation Code from Intuit.

4 Enter the Activation Code, then click OK.

Tip: If the computer isn’t connected to the Internet, go to the Tools menu, select License Products, select Manual, select OK, then follow the instructions in the License Products dialog box shown at the top of this page.

For more information about product licensing:

- Use the Search Help feature on the Help toolbar or in the Help Center, or
- Click the Help button on the toolbar, select User’s Guide in the Help Center, then go to chapter 4, “Setting Up ProSeries Features.”

Be sure to read “Updating your firm’s product licensing information” below.

**Product licensing with multiple, non-Internet computers**

If you installed ProSeries for stand-alone use on computers that don’t have an Internet connection and you don’t want to perform product licensing for each computer using the Manual method, here’s a convenient way to copy your firm’s product licensing information from one computer to other computers.

1 From the computer with your firm’s product licensing information, go to the File menu, select **Copy Product License**, then use the dialog box to save the product license file to a network location or removable media (such as a 3.5-inch disk).

2 From each computer that requires product licensing, go to the File menu, select **Retrieve Product License**, then use the dialog box to retrieve the product license file that you copied to the network location or removable media.

**Tip:** Repeat this procedure if you update the firm’s product licensing information.

**Updating your firm’s product licensing information**

Update your firm’s product licensing information when:

- You purchase additional ProSeries tax products or additional ProSeries electronic filing products for Unlimited use, or
- You purchase ProSeries/Network Version, or
- The software or an Intuit ProSeries representative instructs you to update your product license information

If either of these situations occur, go to the **Tools** menu, select **License Products**, select **Online**, select **OK**, then simply wait for the product licensing procedure to conclude.

**Tip:** If the computer isn’t connected to the Internet, go to the **Tools** menu, select **License Products**, select **Manual**, select **OK**, then follow the instructions in the **License Products** dialog box shown at the top of this page.

For more information about product licensing:
Keeping your ProSeries tax products up-to-date

The various ProSeries tax products are released and updated throughout the tax season. You can install new products and update previously-installed products via the Internet and from ProSeries CDs that you receive, as explained in this section.

**Important:** As soon as a ProSeries tax product or tax product update becomes available, it is posted to the ProSeries Tax Products Internet server. The products and product updates on a ProSeries CD are the same as those that are available for download via the Internet days or weeks before you receive the ProSeries CD.

Getting products and updates via the Internet

Getting tax products and product updates via the Internet helps you have the most up-to-date versions of the ProSeries tax products that you use.

**Using Task Scheduler.** Task Scheduler provides an easy way to get ProSeries tax products and product updates via the Internet.

To use Task Scheduler, take the following steps from each computer on which the ProSeries program is installed for stand-alone use. If the ProSeries program is installed for network use, take these steps from the ProSeries Admin workstation.

1. Go to the **Tools** menu, select **Options**, then select **Task Scheduler** on the left side of the **Options** dialog box.
2. Enable the **Download New/Update Existing Products** task. (There’s a check in the box before the task when it’s enabled.)
3. To change the Task Scheduler schedule, select **Modify**, then select the day(s) of the week that you want Task Scheduler to run and a time that’s convenient for you.
4. Make sure the computer is on when Task Scheduler is scheduled to perform tasks.

**Password.** Task Scheduler must be able to connect to the Internet “unattended.” If your Internet connection requires a password, that password must be stored and available.

Here are two other ways to get products and product updates via the Internet:

- Click the **Start** button on the Windows desktop, select **Programs**, select **ProSeries 2007**, then select **ProSeries Update**.
- Start the ProSeries program, go to the **Update** menu, then select either **Select and Download New Products** or **Update Installed Products**.

Getting products and updates from ProSeries CDs

To install ProSeries products and product updates from the ProSeries CDs that you receive during the tax season, take the following steps from each computer on which the ProSeries program is installed for stand-alone use. If the ProSeries program is installed for network use, take these steps from the ProSeries Admin workstation.

1. Insert the ProSeries CD into the CD drive.
2. Allow the installation program to install the appropriate ProSeries products and product updates from that ProSeries CD.
3. If you want to review the products that are selected for installation or select additional products to install, click the **Select Additional Products** button.
4. After you review the products that are selected for installation or select additional products in the **Tax Year 2007 Product Selections** dialog box, select **OK**.
Network. When a ProSeries tax product is installed or updated on the network drive from
the ProSeries Admin workstation, that tax product or tax product update becomes
available to all workstations on which you installed and set up the ProSeries program.

Software service and ProSeries CD delivery information

<table>
<thead>
<tr>
<th>ProSeries CD name</th>
<th>Approximate ship date</th>
<th>The CD includes these ProSeries tax products</th>
</tr>
</thead>
<tbody>
<tr>
<td>Head Start CD</td>
<td>November 15</td>
<td>Client Organizer, Draft 1040, 706, plus the ability to download tax products when they become available for download starting in December</td>
</tr>
<tr>
<td>Tax Release 1 CD</td>
<td>December 27</td>
<td>Initial 1040, 1120, 1120S, 1065, 709, individual state products, and business state products</td>
</tr>
<tr>
<td>Tax Release 2 CD</td>
<td>February 18</td>
<td>Final 1040, 1040NR, 1041, 990, remaining individual state products, remaining business state products, and other products if necessary</td>
</tr>
<tr>
<td>Archive CD</td>
<td>March 31</td>
<td>All final products</td>
</tr>
</tbody>
</table>

Important: Actual shipping dates and the exact contents of a CD are subject to change.

For more information about keeping your ProSeries tax products up-to-date:

- Use the Search Help feature on the Help toolbar or in the Help Center, or
- Go to the Help Center, select Tutorial Videos, select Program Setup and Maintenance, then select Downloading New Products and Updates to see a tutorial video that includes information about the form status and form availability features.
- Click the Help button on the toolbar, select User’s Guide in the Help Center, then go to chapter 2, “Updating ProSeries Tax Products.”

Product release dates and the status of forms

You have many options for getting product release dates and information about the status of forms:

- If a return is open and the Form Status bar is on the screen, select the right side of the Form Status bar to go to the Release Dates page for that product in ProSeries.com.
- If the middle part of the Form Status bar indicates the form is “Delayed,” select that text to see an explanation for the delay in a pop-up dialog box.
- Go to the Help Center, then select Release Dates & Form Status to go to the overall Release Dates page in ProSeries.com.
- Go to the Help Center, select ReadMe Information, then select a product.

Tip: The ReadMe information for a ProSeries tax product identifies any forms that are not ready to be filed yet. When a product is updated, its ReadMe Information is updated.

- For information about product release dates and the status of forms, go to http://www.proseries.com, select Support, then select Release Dates.
- For information about release dates and the products you’ve purchased, go to http://www.proseries.com, then log in to your personalized My ProSeries page.

Important: Final Review identifies non-final forms in the open return. If you open a form that can’t be filed yet, you see “NOT FINAL” on the Form Status bar. If you print a form that can’t be filed yet, you see a “DO NOT FILE” or “DRAFT FORM” watermark. Don’t file a return unless you have the final version of all the forms that are included in the return.
Preparing your clients’ federal and state returns

After you complete the first-time start-up procedures, you see ProSeries HomeBase. HomeBase summarizes information about your clients and client files.

From HomeBase, you start new client files, open existing client files, and perform a variety of other tasks involving your client files, such as electronic filing.

The first time you start the ProSeries program, you see client information in HomeBase only if you transferred information from last year’s ProSeries client files. As you work on client returns and save client data, you see information about those clients in HomeBase.

To see information about the clients who meet specific criteria, click the HomeBase View field near the top-left corner of HomeBase, then select the HomeBase view that you want from the HomeBase View list. To open a client file from a HomeBase view, double-click it.

The ProSeries federal products that are installed determine which HomeBase views are available. ProSeries federal products are 1040, 1040NR, 1065, 1120, 1120S, 1041, 990, 706, 709, and Client Organizer. If appropriate, the HomeBase View list also includes “EF Center,” “Bank Products,” and “Client Analyzer Queries.” The last entry on the HomeBase View list is “All Tax Returns.”

Tip: If you install only Client Organizer from the HeadStart CD, the HomeBase View list contains only “Organizer for 1040” and “All Tax Returns.”

State products aren’t reflected in the HomeBase Views—except for the EF Center and Client Analyzer Queries views. With ProSeries, you start new state returns and open previously-saved state returns from the client’s federal return. (You start and open your clients’ federal returns from HomeBase.)
Starting and opening federal returns

When you start a new federal return or open a previously-saved federal return, the Information Worksheet designed for that type of return opens in the Client Data window.

From the Client Data window, you can:

- Open forms, schedules, worksheets, and other items using the Forms Bar
- Enter, edit, and delete data for the current client
- Check the current client’s return for errors
- Save the current client’s data in a client file
- Import data from Quicken, QuickBooks, or other software
- Set up ProSeries options and features
- Get information and help using the Help toolbar

**Important:** To get information about a specific topic, enter keywords in the Search Help field on the Help toolbar or in the Help Center, then click Search. If you want information about a specific type of return, open a return of that type before you search.

The Federal Information Worksheet, which is the starting point for all Form 1040 returns, is shown next. The **Taxpayer: Last Name** field is selected in this illustration.

Opening forms, schedules, and worksheets

The ProSeries program offers several ways to open forms, schedules, worksheets, and other items, including the Forms Bar, QuickZoons, the Open Forms dialog box, and the Where Do I Enter? search feature.
Using the Forms Bar

When a client’s federal or state return is open, the Forms Bar on the left side of the Client Data window lists forms, schedules, worksheets, and other items for that return.

**Important:** Select the name of a form, schedule, worksheet, or other item in the Forms Bar to open it in the Client Data window.

The Forms Bar consists of titled sections that contain forms, schedules, worksheets, and/or other items that are associated to the section title. You can expand and collapse each section. Select a section title that’s preceded by [+] to see the entries in that section. Select a section title that’s precede by [-] to hide the entries in that section.

Note the following about the Forms Bar sections:

- **Forms In Use** — Shows only the forms, schedules, worksheets, and other items containing data for the open return. You can identify each separate copy of a form if applicable. Forms with fields that are missing required data or that contain invalid data are identified with red text indicating the number of errors currently on the form.

  **Tip:** Click the red “error” text after the name of a form in the Forms In Use section to go to the errors on that form.

- **Common Forms** — Shows the forms, schedules, worksheets, and other items that are likely to be required for a majority of the returns of the type you’re preparing.

- **Categories of Forms** — Shows all the forms, schedules, worksheets, and other items for the type of return you’re preparing grouped into logical categories. The Categories of Forms section is available for federal returns and some state returns. For some types of returns, some categories have sub-categories.

- **All Forms** — Shows all the forms, schedules, worksheets and other items for the type of return you’re preparing, with forms listed by number, schedules by letter, and worksheets by brief description. (The All Forms section isn’t visible in the illustration.)

  **Tip:** When you move your mouse pointer over the short name of a form, schedule, worksheet, or other item in the Forms Bar, you can see the long name for that form, schedule, worksheet, or other item in a “fly-over” text box.

**Tip:** When you click the right mouse button in the Forms Bar, you can use the Forms Bar menu to close the Forms Bar, see Forms Bar Help, and collapse and expand the sections to their default settings.

Using QuickZooms

Many ProSeries forms include QuickZoom buttons and QuickZoom icons.

- Click a QuickZoom button on a form to open a related form.

- If you see a QuickZoom icon when you select a field on a form, click the QuickZoom icon to open a related form.
Using the Open Forms dialog box

The **Open Forms** dialog box is similar to the Forms Bar. Click the **Open Forms** button on the toolbar to see the **Open Forms** dialog box, then open forms from the dialog box. To open a form from the **Open Forms** dialog box, double-click it, or select it, then click **OK**.

**Tip:** In the **Open Forms** dialog box, letters or numbers that are blue are keyboard shortcuts. The keyboard shortcut for many numbered forms are the form's number, and the keyboard shortcut for many lettered schedules are the schedule's letter.

**Tip:** To open the **Open Forms** dialog box quickly, press the F6 key.

Using the Where Do I Enter? search feature

If you're not sure where to enter some unusual or uncommon data for a federal Form 1040 return or a federal Form 1065 return, click the **Where Do I Enter?** button on the Forms Bar or the toolbar.

When the **Where Do I Enter?** dialog box opens, start typing one or more keywords. As you type, the characters appear in the **Search** field and the search results appear in the **Topic and Form** area. As you continue typing, the search results are refined. To open a form, schedule, worksheet, or other item that's listed in the **Topic and Form** area, click that line.
Preparing more than one copy of a form

When applicable, you can prepare more than one copy of some forms. For example, you can prepare more than one copy of the Form W-2 Worksheet, Schedule C, or Form 4562 for individual federal returns.

When you open a form for which more than one copy is available, the **Multiple-Copy Form** dialog box opens.

- To open an existing copy of the form, click **Select an existing form to open**, select the name of the copy that you want, then click **Select**.
- To prepare a new copy of the form, click **Create new copy**, enter an applicable name for the copy, then click **Create**.

Entering client data on forms, schedules, and worksheets

As you select fields on the tax forms, schedules, and worksheets in your clients’ returns, you’ll see that some fields are available for data entry while other fields are calculated by the ProSeries program from data in the clients’ returns.

**Tip:** Color descriptions are for guidance only. Colors might be different on your monitor.

**Data entry field colors are as follows:**

- **Light Yellow fields** are available for data entry or contain valid data.
- **Light Red fields** require data or contain invalid data.
- **White fields** are calculated by the program.

**Data colors are as follows:**

- **Blue** – Data you enter appears blue in light yellow fields.
- **Red** – Data the program determines is invalid, such as an invalid Social Security Number, appears red in light red fields.
- **Aqua** – Data the program transfers (from last year’s return, from this year’s Client Organizer, or from a federal to a state return) appears aqua in light yellow fields.
- **Black** – Data the program calculates appears black in white fields.

**When you enter data, keep the following in mind:**

- Press ENTER after each entry.
- When you enter a dollar-and-cents amount or a percentage, include the decimal point. The program rounds amounts to the nearest dollar.
- When you enter an amount of more than three digits, the program adds the comma.
- When you enter a negative number, type the minus key before the amount.
- When you start to type data in field that has a list of valid alternatives, the program helps expedite data entry. Click the field to see the list.
- If the program shows one or more ways to complete a data entry:
  - Press ENTER to accept the suggested data if it's correct, or
  - Select the correct alternative from the list of suggested data and press ENTER, or
  - Continue typing the correct data.
If the **ZIP Code Automation** option is selected in the **General** section of the **Options** dialog box when you enter a ZIP code, the program fills in the corresponding City and State fields if they are blank or don’t match the City, State, ZIP code information in the Zip Code database.

If the **Use EIN auto-fill on W-2 and 1099** option is selected in the **Employer/Payer Database** section of the **Options** dialog box when you enter a federal Employer Information Number (EIN) on a Form W-2 Worksheet or a Form 1099 Worksheet, the program fills in information about the employer or payer if that information is available in the Employer/Payer database.

**Important:** As you enter data, go to the toolbar and click the **Save Client Data** button frequently.

For more information about forms navigation, data entry, or other topics, use the Search Help feature on the Help toolbar or in the Help Center.

### Summary of the basic steps to prepare client returns

The following table presents a brief summary of the basic steps to prepare client returns. Note that many optional steps aren’t included in this table.

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Do this...</th>
</tr>
</thead>
</table>
| **1. Start the client’s federal return from HomeBase** | If you transferred last year’s data, select the appropriate HomeBase view, then double-click the client’s name to open the client’s file.  
If you didn’t transfer last year’s data, click the Create New Client File button on the HomeBase toolbar, then select the appropriate federal product.  
The appropriate Information Worksheet opens. |
| **2. Prepare the client’s federal return** | a. **Import** – If there’s relevant client data in QuickBooks, Quicken, or another program, go to the **Import** menu and select the applicable command.  
b. **Enter data** – Enter data in the applicable data fields. Double-click forms in the Forms Bar to open them.  
c. **Save the data** – Click the **Save Current Client File** button on the toolbar often as you enter data.  
d. **Review** – Click the **Final Review** button on the toolbar to correct errors that the ProSeries program identifies. |
| **3. Prepare the client’s state return** | a. **Go to state return** – Click the **Go to State Return** button on the toolbar, then select the appropriate state. If more than one state return is required, prepare the nonresident state returns before the resident state return.  
b. **Enter data** – Enter data in the applicable fields on the state forms.  
c. **Save the data** – Click the **Save Current Client File** button on the toolbar often as you enter data.  
d. **Review** – Click the **Final Review** button on the toolbar to correct errors that the ProSeries program identifies.  
e. **Prepare additional state returns** – To prepare additional state returns, click the ST button on the toolbar, select an applicable state, then repeat steps b through d for each state return that the client must file.  
f. **Go to federal return** – Click the **FED** button on the toolbar to return to the client’s federal return. |
| **4. Print the client’s return(s)** | If the client’s return is open, go to the **File** menu, select **Print**, select **Print This Client**, select the options you want, then click **Print**.  
If HomeBase is on the screen, select the client, go to the **File** menu, select **Print**, select **Print Clients**, select the options you want, then click **Print**. |
Setting up other ProSeries features

Use the information in the following table to set up the following ProSeries features.

<table>
<thead>
<tr>
<th>To do this...</th>
<th>Do this...</th>
</tr>
</thead>
</table>
| **5. File the return(s) electronically** | a. Make sure each return you want to file electronically is marked for electronic filing in *Part VI-Electronic Filing of Tax Return Information* of the Federal Information Worksheet, and that it passes Final Review.  
  b. Click the **EF Now** button on the toolbar, select the client’s return(s) in the **Electronic Filing** dialog box, then select **Yes** in the **Electronic Filing Transmission** dialog box.  
  c. After 24 to 48 hours, click the **Go to EF Center** button on the toolbar, go to the **E-File** menu while in the EF Center, select **Electronic Filing**, then select **Receive Acknowledgment Statuses**. |

**To do this...** | **Do this...** |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Access Rights.</strong> Control access to the program and to specific, critical features</td>
<td>Go to the <strong>Tools</strong> menu, select <strong>Access Rights</strong>, select <strong>Enable/Disable Access Rights Feature</strong>.</td>
</tr>
<tr>
<td><strong>Invoices.</strong> View or edit the standard invoice for a specific type of return</td>
<td>Open a return of that type, go to the <strong>Tools</strong> menu, select <strong>Billing</strong>, then select <strong>View Invoice</strong> or <strong>Edit Invoice</strong>.</td>
</tr>
<tr>
<td><strong>Letters.</strong> View or edit the standard client letter or standard recipient letter for a specific type of return</td>
<td>Open a return of that type, go to the <strong>Tools</strong> menu, select <strong>Letters</strong>, then select <strong>View Client Letter</strong> or <strong>Edit Client Letter</strong>.</td>
</tr>
<tr>
<td><strong>Internet.</strong> Set up an Internet connection so you can use ProSeries connectivity features</td>
<td>Go to the <strong>Help</strong> menu and select <strong>Internet Connection Setup</strong>.</td>
</tr>
<tr>
<td><strong>Product licensing.</strong> License your ProSeries tax products so you can print and file returns electronically</td>
<td>Go to the <strong>Tools</strong> menu, select <strong>License Products</strong>, then select <strong>Online</strong> or <strong>Manual</strong>. (We recommend that you select <strong>Online</strong>.)</td>
</tr>
<tr>
<td><strong>Pay-Per-Return.</strong> Add funds to a pay-per-return account so you can print and file returns electronically (for products you’re using on a pay-per-return basis)</td>
<td>Go to the <strong>Tools</strong> menu, select <strong>Pay Per Return</strong>, then select <strong>Increase Account Balance</strong>.</td>
</tr>
<tr>
<td><strong>Billing clock.</strong> Activate the billing clock so it tracks the time you spend on each return</td>
<td>Go to the <strong>Tools</strong> menu, select <strong>Billing</strong>, then select <strong>Billing Clock</strong>.</td>
</tr>
<tr>
<td><strong>Billing rates.</strong> Set billing rates for the forms and schedules of a specific type of return</td>
<td>After you open a return of the applicable type, go to the <strong>Tools</strong> menu, select <strong>Billing</strong>, then select <strong>Rates Per Form</strong>.</td>
</tr>
<tr>
<td><strong>Merchant account services.</strong> Sign up for merchant account services so you can accept payment by credit card and eChecks</td>
<td>Go to the <strong>Tools</strong> menu, select <strong>Accept Credit Cards/eChecks</strong>, then select <strong>Sign Up</strong>.</td>
</tr>
<tr>
<td><strong>Slip sheets.</strong> Select options for slip sheets to use with envelopes and presentation folders</td>
<td>Go to the <strong>Tools</strong> menu and select <strong>Global Slip Sheet Options</strong>.</td>
</tr>
<tr>
<td><strong>Client templates.</strong> Enter data that applies to all your clients who file a specific type of federal return</td>
<td>Go to the <strong>Tools</strong> menu and select <strong>Edit Client Template</strong>.</td>
</tr>
</tbody>
</table>

For more information about setting up, reviewing, and changing ProSeries features, use the Search Help feature on the Help toolbar or in the Help Center.

To view on-screen demonstrations of many of these features, go to the **Help** menu, select **Help Center**, select **Tutorial Videos**, then select the applicable tutorial video.
Getting information and help

The ProSeries Help system includes a Help toolbar with three features to help you get the information that you need quickly and easily. From right to left, those features are Search Help, Most Common Support Questions, and Field/Form Help (when a return is open).

When a return is open, the Help toolbar can show one line of information (minimized) or four lines of information (maximized). The first time you open a return in this year’s program, the Help toolbar is minimized by default, as shown in the next illustration.

To maximize the Help toolbar to four lines of information, click the Maximize/Minimize control to the right of the Search button on the right side of the Help toolbar. The Help toolbar remains maximized until you click the Maximize/Minimize control again.

In the next illustration, the Help toolbar is maximized.

**Search Help**

To get answers to a question or information about a key word or phrase, type the question, word, or phrase in the Search Help field, then click the Search button or press the ENTER key.

The program searches the applicable ProSeries Help content, then lists the search results in the Help Center. Click the blue, underlined title of a search result in the Help Center to see the full content of that information source.

The program identifies the total number of search results near the top of the page, and it lists a maximum of ten search results on each page. When applicable, click Next Page and Previous Page at the bottom of a page to see other pages of search results.

**Most Common Support Questions**

Most Common Support Questions are linked to information in ProSeries Help. Click the blue, underlined word “more” to see all the Most Common Support Questions for the current location. Click a question to see the relevant information in the Help Center.
**Field/Form Help**

When you’re working on a return, the left area of the Help toolbar shows information about the currently-selected field or form. Click the blue, underlined text or the word “more” to see all the current Field/Form Help information in the Help Center. Field/Form Help includes Tax Help, Cross-references, and Government Instructions.

**Using the Help Center**

All three features in the Help toolbar open the Help Center. From the Help Center, you can get a variety of information quickly from one, easy-to-use location.

**Tip:** The Help Center opens when you click the **Help** button on the toolbar.

The Help Center is divided into the following four sections:

- **Tax Return Help** — Provides information about the open tax return
- **ProSeries Help** — Provides information about using the ProSeries program
- **Technical Support** — Provides important product information
- **ProSeries.com** — Is a resource for online help tools and information

For more information about ProSeries Help, use the Search Help feature near the top-left corner of the Help Center to find the information that you want.

**Tip:** Tutorial Videos (available from the **ProSeries Help** section) explain how to use a specific feature and end with a summary of the main steps for using that feature.
Using the on-screen ProSeries User’s Guide

The ProSeries User’s Guide is the most comprehensive source of information for all aspects of using ProSeries software. The User’s Guide is automatically installed on your system so you can search it using the Search Help feature.

Here are three ways that you can open the ProSeries User’s Guide:

● In the ProSeries program, go to the Help Center and select User’s Guide.
● From HomeBase, go to the toolbar and click the User’s Guide button.
● From the Windows desktop:
  1. Go to the taskbar and click Start.
  2. On the Start menu, point to Programs, then point to ProSeries 2007.

When the ProSeries User’s Guide opens, you see the title page and Table of Contents in the ProSeries User’s Guide browser window.

● Click a topic in the Table of Contents to see that information in the display area to the right of the Table of Contents.
● Use the scroll bars to see information in the Table of Contents and the display area.
● Click blue, underlined phrases to see more information about those topics.
● Click the Printer icon near the upper-right corner of the browser window to print the current topic.
● Click the Index and Search tabs to use those User’s Guide features.

Tip: For detailed information about the various ways to get information and help about ProSeries software, open the ProSeries User’s Guide, then go to chapter 1, “Getting Help.”

Using ProSeries.com and My ProSeries

ProSeries.com (http://www.proseries.com) includes up-to-date information about ProSeries products and services.

My ProSeries provides content that’s customized for you, such as:

● Status of your orders, and release dates of products you’ve purchased
● Status of each form in a product, and when the final version of each form is expected to be available for download or became available for download
● A way to complete product licensing manually
● Technical Support answers to current support issues
● Chat support with a ProSeries technical support agent
● E-mail support with historical logs of your e-mail correspondence
● Links to various helpful Web sites
● Training material and other useful information, including ProSeries User Guides

Important: You must set up an account to use My ProSeries so we can provide you with information specific to your ProSeries products.
Filing returns electronically

ProSeries/Electronic Filing software is installed with ProSeries tax products that support electronic filing. ProSeries software supports electronic filing of the following:

- Federal individual returns and extension request forms,
- State individual returns (for 41 states and the District of Columbia) and extensions (for Massachusetts and New York),
- Minnesota property tax refund returns, and
- The federal and state business returns and extension request forms that are discussed in “Filing federal or state business returns and extensions” on page 46.

To visit the Web site for a state’s tax agency, go to http://www.proseries.com, select Resources, select State Tax Departments in the General Tax Resources section, then select the name of the state.

Important: If you don’t have an IRS-issued Electronic Filing Identification Number (EFIN) yet, see “Preparing for electronic filing” on page 4.

For detailed information about electronic filing:

- Go to http://www.proseries.com, select Products, then select Electronic Filing, or
- Use the Search Help feature on the Help toolbar or in the Help Center, or
- Go to the Help menu, select Help Center, select Tutorial Videos, then select an applicable video in the Electronic Filing area, such as Electronic Filing – Overview, Electronic Filing – Setting up a Return, Electronic Filing – Preparing a Return, or Electronic Filing – Transmitting up a Return.
- Click the Help button on the toolbar, select User's Guide in the Help Center, then go to chapter 20, “Electronic Filing.”

Establishing an Internet connection

To file electronically, the computer on which the ProSeries program is installed must be able to connect to the Internet. If you don’t have an Internet connection, you must first sign up for service with an Internet Service Provider (ISP). Once you have an ISP, go to the Help menu, select Internet Connection Setup, then follow the instructions on the screen.

Setting up the ProSeries program for electronic filing

If you’ve already entered your electronic filing information, proceed to “Step 1 - Mark the return(s) for electronic filing” on page 39.

If you haven’t entered your electronic filing information yet, take the following steps to set up the ProSeries electronic filing options.

1. Go to the Help menu and select Options Setup Wizard.
2. In the first Options Setup Wizard dialog box, select Express Setup.
3. EFINs. In the Firm/Preparer Information dialog box, enter the firm’s Electronic Filing Identification Number (EFIN) in the Firm Information section, and enter preparers’ Electronic Filing Identification Numbers (EFINs) in the Preparer Information section. After you enter an EFIN, complete the corresponding Efile Contact Name fields.

   PINs. PINs (Personal Identification Numbers) are used as electronic signatures. Enter each preparer’s PIN in the ERO Practitioner PIN field. A Practitioner PIN is any five-digit code (except all zeros) chosen by each preparer.
Important: Beginning with the 2008 filing season (starting in January 2008), the IRS requires that tax practitioners e-file individual income tax returns with Practitioner PINs or taxpayer Self-Select PINs. Tax practitioners will no longer be able to submit a paper signature for e-filed returns by using Form 8453. A redesigned Form 8453 will be used only to transmit required supporting paper documents.

4 In the Filing Client Returns Electronically dialog box, select Yes, some returns may be filed electronically.

5 Complete the remainder of the Options Setup Wizard.

Tip: For on-screen instructions, go to the Help menu, select Help Center, select Tutorial Videos, select Electronic Filing, then select Electronic Filing - Overview.

If more than one computer will be using the same EFIN

When ProSeries software is installed on a computer, the DCN (Declaration Control Number) counter is set at “00001.” The program assigns that number to the first federal return that’s marked for electronic filing, then increments the DCN counter by “1.” As each subsequent federal return is marked for electronic filing, the program assigns the current DCN to that return, then increments the DCN counter by “1.”

Important: If your firm will be filing returns electronically from more than one non-networked computer, and each computer is using the same EFIN, change the starting number in the DCN counter in the Options dialog box on all but one computer before preparers start to transfer or prepare returns. By advancing the DCN counter sufficiently on each “additional” stand-alone computer, each return marked for electronic filing will be assigned a unique DCN. For example, advance the DCN counter to “01001” on the second computer, to “02001” on the third computer, and so on.

Tip: If a computer will be using a unique EFIN, it’s not necessary to change the starting number in the DCN counter for that computer.

To change the starting number in the DCN counter for a computer:

1 Go to the Tools menu, then select Options.

2 Select Electronic Filing in the left side of the Options dialog box.

3 Go to the DCN Counter field and increase the number.

Tip: The Options Setup Wizard also provides a way to adjust the DCN counter.

Important: The next sections focus on electronic filing and individual returns. For information about electronic filing and business returns and extensions, see “Filing federal or state business returns and extensions” on page 46.
Step 1 - Mark the return(s) for electronic filing

To mark a client’s federal and state individual returns for electronic filing:

1. Open the client’s federal individual return, go to the Federal Information Worksheet, scroll down to Part V-Return Preparer and Third Party Designee Information, then make sure the appropriate preparer code is entered in the Preparer Code field.
   **Tip:** If you’re acting as an ERO and filing a return for another preparer, enter that person’s preparer code in the Preparer Code field.

2. Scroll down to Part VI - Electronic Filing of Tax Return Information, then make sure the File federal return electronically box is checked.

3. **State returns.** If you’re going to file the client’s state return (or returns) electronically, make sure the File state return electronically box is checked and select the appropriate state return(s) in the State(s) table.

Note the following about the three EF filing types for state individual returns.

<table>
<thead>
<tr>
<th>EF filing type</th>
<th>States</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Independent</td>
<td>California, Illinois, Maine,</td>
<td><strong>Independent</strong> EF filing type state returns don’t have to be electronically filed with the corresponding federal return. Returns for these states are electronically filed directly with the state taxing authority.</td>
</tr>
<tr>
<td></td>
<td>Massachusetts, and Minnesota</td>
<td></td>
</tr>
<tr>
<td>Fed/State</td>
<td>Hawaii and Oklahoma</td>
<td><strong>Fed/State</strong> EF filing type state returns must be electronically filed with the corresponding federal return. Returns for these states are electronically filed to the IRS, then sent to the state taxing authority.</td>
</tr>
<tr>
<td>Fed/State or State-Only</td>
<td>35 states that aren’t an Independent state or a Fed/State state</td>
<td><strong>Fed/State or State-Only</strong> EF filing type state returns don’t have to be electronically filed with the corresponding federal return. Returns for these states are electronically filed to the IRS, then sent to the state taxing authority.</td>
</tr>
</tbody>
</table>
**Important:** The program won’t allow you to electronically file a client’s **Fed/State** state return without the client’s federal return.

4 **DCN information.** Note that the program assigns a DCN to the client’s return(s).

**PIN information.** Complete the appropriate fields in the Practitioner PIN Program section.

**QuickZOOMs.** When applicable, use the QuickZoom buttons near the end of Part VI to go to the appropriate worksheet(s) and/or statement.

5 **Direct Deposit/Direct Debit.** If the client wants their refund deposited directly into their account or the balance due withdrawn from their account, complete **Part VIII - Direct Deposit/Electronic Funds Withdrawal Information.**

---

**Step 2 - Prepare the return(s) for electronic filing**

To prepare a client’s individual return(s) for electronic filing:

1. **Complete the client’s federal return.**

   **Tip:** See “Avoiding common reasons for rejection” after Step 8.

2. **Complete the Electronic Filing Smart Worksheets on the client’s Form W-2, 1099-R, W2-G, and 1099-G worksheets (if applicable).**

3. **RAL or RT.** If you’re offering bank products through Santa Barbara Bank & Trust and the client wants a Refund Anticipation Loan or Refund Transfer, complete the applicable parts of the Bank Product Information Worksheet.

   For more information, see “Overview of Bank Products” on page 47.

   **Tip:** For Form 1040 returns, the **EF & Banking** section of the Forms Bar lists forms, schedules, worksheets, and other items for electronic filing and bank products.

4. **Go to the toolbar and click the Go to State button.** If more than one state product is installed, select a state in the Go to State dialog box.

   **Important:** If the client must file more than one state return, prepare the client’s resident state return last.

5. **Complete the client’s state return.**
6 If you need to prepare additional state returns, go to the toolbar, click the Go to State button, then select an appropriate state. Repeat these steps for each state return.

7 Go to the toolbar and click the Go to Fed button.

8 Go to the toolbar and click the Save Client button.

Avoiding common reasons for rejection

- Verify the client’s social security number (SSN) and Date of Birth (DOB) with the Social Security Administration (SSA).
- If you’re preparing a Married Filing Joint return, verify that the spouse’s last name on the return matches the spouse’s last name on his or her Social Security card.
- Make sure the employer’s name and federal identification number on the actual Form W-2 match the information you’ve entered in the ProSeries program.
- Make sure the payer’s name and federal identification number on the actual Form W-2G or Form 1099-R match the information you’ve entered in the ProSeries program.
- Use error-checking during data entry. To do so, go to the View menu and make sure there’s a check mark before Error Alerts.

Step 3 - Run Final Review from the return(s)

After you complete a federal or state return, run ProSeries Final Review to help you check the return for errors.

1 To review the open federal or state return, go to the toolbar and click the Final Review button. We recommend that you select every option in the Final Review Choices dialog box.

2 Analyze the Final Review report, and fix all errors that are identified.

3 Click Recheck to help ensure the return doesn’t contain any new errors.

4 Go to the IRS e-file Authentication Statement in the client’s federal return, make sure the box at the top of the form is checked, then complete the remainder of the form.

   Tip: For more information, click the Help button while the IRS e-file Authentication Statement is open on the screen.

   Take similar steps for the client’s state return(s) if applicable.

5 Print Form 8879, IRS e-file Signature Authorization, in the client’s federal return, then instruct the taxpayer (and spouse if applicable) to sign and date the form.
Important: You are required to keep a signed and dated copy of Form 8879, IRS e-file Signature Authorization, for three years. Take similar steps for the client’s state return(s) if applicable.

6 Review the federal return and any state returns (including forms concerning electronic filing and bank products) with the client before proceeding.

7 If you determine that the client must submit printed copies of specific documents after the client’s federal return has been accepted by the IRS, review Form 8453 in the client’s federal return. Also review any corresponding electronic filing paperwork forms in the client’s state return, if applicable.

Important: The IRS has revised Form 8453 for the 2007 tax year.

Tip: If you go to the E-File menu and select Return Ready to EF while a return is open, the program assigns the Return Ready to EF status to that return (and only that return).

Step 4 - From the EF Center, select the return(s)

To select individual returns for electronic filing:

1 Go to the toolbar and click the Go to EF Center button to go to the HomeBase EF Center. The HomeBase EF Center presents important information about each client return that you’ve prepared and marked for electronic filing, including the status of each return.

2 Select the individual returns that you want to file electronically. Their status should be Return Ready to EF, Return Marked for EF, or Return Ready to Transmit.

Tip: If the Only Transmit Returns when Status is Set to ‘Return Ready to EF’ option is selected in the Electronic Filing section of the Options dialog box, the status of each return must be Return Ready to EF.

To select consecutive client returns, click the first client return, then hold down the SHIFT key and click the last client return.
• To select non-consecutive client returns, hold down the CTRL key while you click each client return.

**Fed type.** Individual returns (both federal and state) show 1040 in the Fed Type column.

**State returns.** State returns are listed after the corresponding federal return. In most cases, you should select a client’s federal and state returns at the same time.

**Tip:** While California, Illinois, Maine, Massachusetts, and Minnesota returns do not need to be electronically filed with the corresponding federal return, it’s best to do so. If a North Dakota or South Carolina return isn’t filed with the corresponding federal return, it can’t be electronically filed until the federal return is accepted.

**Step 5 - Convert and transmit the selected return(s)**

To electronically file the individual returns that you selected in step 4:

1. Go to the toolbar and click the E-File button.
2. If any informational dialog boxes appear, read the information, then select OK.
3. If you see a Pay-Per-Return dialog box, authorize payment for the indicated client files.
4. In the Electronic Filing Options dialog box, select Convert and Transmit selected returns/extensions.
5. Make sure Enable conversion error checking is selected.
   **Tip:** A return that cannot pass error checking will usually get rejected by the IRS. Therefore, do not disable conversion error checking unless directed to do so by a Technical Support Representative.
6. Select OK.

When the ProSeries program finishes converting and transmitting the returns, the Transmit Electronic Filing Returns/Extensions Log opens so you can review the results.

**Step 6 - Wait 24 to 48 hours, then check for acknowledgments**

**Tip:** ProSeries automatically checks for acknowledgments when you transmit client returns. It may take more than 48 hours to receive an acknowledgment for some federal and state returns.

**Tip:** To view a ProSeries tutorial video on this subject, go to the Help menu, select Help Center, select Tutorial Videos, select Electronic Filing, then select Electronic Filing - Managing Statuses in HomeBase.

To check for acknowledgments from the IRS or state taxing authorities:

1. In HomeBase or from an open return, go to the toolbar and click the Go to EF Center button.
2. Select the client’s return in the EF Center, click the right mouse button, then select View Electronic Filing Status History to open the Electronic Filing Client Status History for that federal or state return.
   **Tip:** There’s a separate Electronic Filing Client Status History for each federal and state return. Open the Electronic Filing Client Status History for each return.
Review the Electronic Filing Client Status History and identify the most recent status of the client’s federal or state return, then select Close.

Tip: If a client’s return was rejected, the report shows why it was rejected, and how to fix the error.

4 If the most recent status of the return is “Return Accepted,” proceed to “Step 7 - Complete the electronic filing process” on page 45.
If the most recent status of the return is “Return Rejected,” proceed to “Resolving a problem with a rejected return” that follows Step 9 below.
If the most recent status of the return isn’t “Return Accepted” or “Return Rejected,” continue with Step 5.

5 Go to the E-File menu and select Electronic Filing.

6 From the Electronic Filing menu, select Receive Acknowledgment Statuses to get the latest acknowledgments.

7 If applicable, select the appropriate EFINs.

8 In the Receive Electronic Filing Acknowledgments Log, select View Acks to see the detailed Acknowledgment Report.
If there aren’t any acknowledgments, View Acks is not available. In most cases, you will receive a client’s federal acknowledgment before you receive the client’s state acknowledgment.

9 Review the information, then select Close. If the return was rejected, continue with “Resolving a problem with a rejected return” next.

Resolving a problem with a rejected return

To resolve a problem with a rejected return:

1 From the EF Center, go to the Electronic Filing menu, select Reports, then print a Rejected Returns report.

2 Incorrect SSN. If a return was rejected because the taxpayer’s social security number wasn’t correct, print the Intuit Electronic Postmark Report before correcting the social security number and resubmitting the return. This provides the original date and time of filing.

3 Fix the errors in the rejected return.

4 Make sure the corrected return passes Final Review.

5 Convert and retransmit the corrected returns as explained in “Step 4 - From the EF Center, select the return(s)” on page 42 and “Step 5 - Convert and transmit the selected return(s)” on page 43.

Re-filing state returns. If you’ve filed a client’s federal and state returns together and the federal return is accepted but the state return is rejected, in most cases you can re-file the corrected state return electronically.

Hawaii and Oklahoma returns. You cannot re-file corrected Hawaii returns or Oklahoma returns electronically because they can only be filed with the client’s federal return. To re-file a corrected Hawaii return or Oklahoma return, you must print the return, then mail it to the appropriate state taxing authority.
Step 7 - Complete the electronic filing process

Federal return. After you receive an acknowledgment that the IRS has accepted a client’s federal individual return, take these steps:

1 Form 8453. If the client is required to file additional documents with the IRS, print Form 8453, U.S. Individual Income Tax Transmittal for an IRS e-file Return, attach the required paper documents to Form 8453, then mail Form 8453 and the attached documents to the appropriate IRS service center within the applicable time period.

Tip: The Preparing Form 8453 section of the Electronic Filing Information Worksheet identifies the paper documents to attach to the client’s Form 8453.

Tip: The Additional Information Smart Worksheet on Form 8453 shows the address to which the client’s Form 8453 should be mailed.

2 Print Form 9325. Print Form 9325, Acknowledgment and General Information for Taxpayers Who File Returns Electronically, if you want to give the form to the client.
   a. Open the client’s federal return.
   b. Go to the File menu, select Print, then select Print Selected Forms.
   c. Select Choose, select Form 9325: General Information for Electronic Filers, then select OK.
   d. Select Print.

IRS refund cycle. For information about the IRS refund cycle, go to the IRS Web site at http://www.irs.gov.

Tip: The use of Form 9325 is optional, but you do need to retain a completed copy of Form 8879, IRS e-file Signature Authorization, that's been signed by the client. You might need to retain a completed copy of state electronic filing paperwork also.

3 Balance due. If the client's federal return has a balance due and the client did not elect to have their bank account directly debited, print Form 1040-V, Balance Due Payment Voucher, and give it to your client.

Important: If your client owes federal taxes, he or she must mail Form 1040-V and the payment to the IRS no later than April 15, 2008.

State returns. After you receive an acknowledgment that the state taxing authority has accepted a client’s state individual return, take these steps:

1 Mail the completed state electronic filing paperwork to the appropriate state service center within the time period required by appropriate taxing authority (if the state taxing authority requires electronic filing paperwork).

Tip: You might need to retain a completed copy of state electronic filing paperwork.

2 Balance due. If the client owes state taxes, follow the state instructions. You’ll probably need to give the client a printed copy of a completed state tax payment voucher along with appropriate instructions.

Getting current information. To review common reject reasons, troubleshooting information, and frequently-asked questions from ProSeries.com, do either of the following:

• While in the ProSeries EF Center, go to the Steps to E-File section, then click the View Frequently Asked EF Questions button.
• While in your Internet browser, go to http://www.proseries.com, select Products, select Electronic Filing, then select E-Filing FAQs.

Tip: To quickly see key information about the status of a client’s electronically-filed Form 1040 return, go to the View menu, select Client Snapshot, enter the client’s name or social security number in the Find a 1040 Client field, then click Search.
Filing federal or state business returns and extensions

ProSeries supports electronic filing of the following types of business returns and extensions:

- Federal corporation, S corporation, partnership, and fiduciary returns and extensions
- Amended federal corporation and S corporation returns
- California corporation, S corporation, partnership, and Limited Liability Company returns
- Georgia corporation and S corporation returns
- Maryland corporation and pass through entity returns and extensions
- Massachusetts corporation, S corporation, partnership, and fiduciary returns
- Massachusetts corporation and S corporation extension request forms
- Michigan Single Business Tax returns
- New York corporation and S corporation returns and extensions
- Wisconsin corporation, S corporation, and multistate corporation returns

The steps to file federal and state business returns electronically are similar to the steps to file federal and state individual returns electronically. However, note the following:

- **PINs.** You can file federal business returns electronically using your IRS Practitioner PIN, but the IRS doesn't require that you use PINs when filing federal business returns electronically.

- **State returns.** If the client will be electronically filing a federal corporation, S corporation, partnership, or fiduciary return and one or more corresponding state returns mark the client’s state business return(s) for electronic filing on the Information Worksheet in the client’s federal return, then select the applicable state return type(s) in the State(s) table.

  **Tip:** If the client will be filing a federal individual return and Michigan Single Business Tax return, mark the client’s Michigan Single Business Tax return for electronic filing on the Federal Information Worksheet in the client’s federal return by selecting Michigan SBT.

- **Fed type.** The Fed Type column in the EF Center identifies the type of business return. For each business return, the entry is either 1120, 1120S, 1065, 1041, or 990.

- **Return type.** The Return Type column in the EF Center identifies the federal or state return. For federal business returns, the entry is Federal. For state business returns, the entry is either CA (California), GA (Georgia), MA (Massachusetts), MD (Maryland), MISBT (Michigan), NY (New York), or WI (Wisconsin).

For detailed information about electronic filing, including instructions on how to file business returns and business extension request forms electronically:

- Go to http://www.proseries.com, select Products, then select Electronic Filing, or
- Enter appropriate keywords or a question in the Search Help field on the Help toolbar or in the Help Center, then click the Search button, or
- Go to the Help Center, select Tutorial Videos, select Electronic Filing, then select Electronic Filing - Business Returns or Electronic Filing - Business Extensions, or
- Click the Help button on the toolbar, select User’s Guide button in the Help Center, then go to chapter 20, “Electronic Filing.”
Overview of Bank Products

When you file your clients’ federal individual returns electronically, those clients may be eligible to receive a loan based on their expected federal refunds in the form of bank products such as Refund Anticipation Loans (RALs), Refund Anticipation Loan Direct Deposits (RALDDs), Refund Transfers (RTs), and Refund Transfer Direct Deposits (RTDDs). In addition, your fees are deducted from the client’s refund and deposited into your bank account electronically.

**Important:** Starting with the 2007 tax year, you can offer Refund Transfers or Refund Transfer Direct Deposits based on the expected state refund from one state under certain circumstances if you’re offering bank products through Santa Barbara Bank & Trust.

As a general rule, a client is eligible for a bank product if:
- The client is due a federal refund, and
- You’re filing the client’s federal return electronically

ProSeries/Bank Products software through Santa Barbara Bank & Trust is included with ProSeries/1040 and integrates seamlessly with ProSeries/Electronic Filing. However, you can offer bank products through Republic Bank instead of Santa Barbara Bank & Trust.

**Tip:** To view a ProSeries tutorial video on this subject, go to the Help menu, select Help Center, select Tutorial Videos, select Electronic Filing, then select Bank Products.

For more information about offering bank products through Santa Barbara Bank & Trust or Republic Bank:
- Go to http://www.proseries.com, select Products, then select Bank Products, or
- Use the Search Help feature on the Help toolbar or in the Help Center, or
- Click the Help button on the toolbar, select User’s Guide in the Help Center, then go to chapter 21, “Bank Products.”

The following table summarizes the basic steps for offering bank products to your clients through Santa Barbara Bank & Trust:

<table>
<thead>
<tr>
<th>To take this step...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Apply to Santa Barbara Bank &amp; Trust to participate in their bank products program.</td>
<td>Go to <a href="http://www.proseries.com">http://www.proseries.com</a>, select Products, then select Bank Products, then select Enroll Now with SBBT to apply to Santa Barbara Bank &amp; Trust.</td>
</tr>
</tbody>
</table>
| 2. Set the ProSeries Bank Products options. | a. Go to the Tools menu, select Options, then select Bank Products.  
  b. Select the Bank Products options that you want.  
  c. Select Registration Information, then enter the requested information in the Bank Products Registration Information dialog box. |
| 3. Transmit your registration information to Santa Barbara Bank & Trust (any time after 12:00 a.m. PST on 12/1/07). | a. Go to the HomeBase Bank Products view.  
  b. Go to the E-File menu, select Bank Products, then select Transmit Registration Information.  
  c. If applicable, select the appropriate EFINs. |
| 4. Check for the registration acceptance status from Santa Barbara Bank & Trust. | a. Go to the HomeBase Bank Products view.  
  b. Go to the E-File menu, select Bank Products, then select Receive Acknowledgments.  
  c. If applicable, select the appropriate EFINs. |
### To take this step... | Do this...
--- | ---
5. Prepare the client’s federal return for a bank product. | a. Prepare the client’s federal and state return(s).
   b. Prepare the client’s federal return (and state return(s) if applicable) for electronic filing.
   c. Complete the Bank Product Information Worksheet in the client’s federal return.
   d. Review the client’s return(s) and make sure the return(s) successfully pass Final Review.
   e. Print the Refund Application Loan (RAL) and Refund Transfer (RT) Application and Agreement form from the client’s federal return, and have the taxpayer(s) sign it.
6. File the client’s return(s) electronically. | a. Go to the EF Center and select the client’s return(s).
   b. Go to the E-File menu, select Electronic Filing, then select Convert/Transmit Returns and Extensions.
7. Receive bank product print authorizations and status messages (after the electronic filing status for the client’s federal return and/or state return becomes “Return Accepted”). | a. Go to the HomeBase Bank Products view.
   b. Go to the E-File menu, select Bank Products, then select Receive Acknowledgments.
   c. If applicable, select the appropriate EFINs.
8. Print the client’s Refund Anticipation Loan check or Refund Transfer check(s). (This step isn’t applicable for direct deposits.) | a. If “Ready to Print” appears in the Status column of the HomeBase Bank Products view, select the client.
   b. Go to the E-File menu, select Bank Products, then select Print Checks...
   c. Deliver the check(s) to the client.
9. If there’s a problem with a check, resolve the problem. | a. Go to the HomeBase Bank Products view and select the client whose check is affected.
   b. Go to the E-File menu, select Bank Products, then select Resolve Check Problems...
10. View or print Bank Products reports. | a. Go to the HomeBase Bank Products view and select the client returns that you want to include in the report.
    b. Go to the E-File menu, select Bank Products, then select Bank Product Reports.

For detailed information about bank products:
- Go to http://www.proseries.com, select **Products**, then select **Bank Products**, or
- Enter appropriate keywords or a question in the Search Help field on the Help toolbar or in the Help Center, then click the Search button, or
- Click the Help button on the toolbar, select **User’s Guide** in the Help Center, then go to chapter 21, “Bank Products.”

**Tip:** To quickly see key information about the status of a bank product for a client’s electronically-filed Form 1040 return, go to the View menu, select **Client Snapshot**, enter the client’s name or social security number in the Find a 1040 Client field, then click Search.